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This addendum to the manual assumes that the installation is complete. All
components of the system should be in place and functioning before you
begin system measurements.

There are many different ways to think about the installation of a system in
a car. The most important consideration is what you want the end result to be.
Some people want to reproduce exactly what the mixing engineer heard in
the control room when the recording was made. Others want the car to
vibrate the pavement as much as possible. Some may try to achieve a happy
medium between these two extremes.

When your goal is to realistically reproduce the original recording, you will
want to spend most of your time working towards a flat frequency response
with good balance between the left and right channels.

When dynamic music is being played, such as classical or jazz, the noise floor
of the system becomes very critical. Special attention should be paid to road
noise and the electrical noise of the system with no music playing.

If you want to win a high SPL competition, you will want to create a curve with
most of it's energy in the low frequencies, because you can take advantage
of the low frequency pressurization effect that occurs in small acoustic spaces
to generate higher SPL scores.

Whether you want a ground-pounding bass generator or an audiophile's
dream vehicle, the measurement process includes the same basic steps. For
system measurements, the process is simple. Make noise with the system and
measure it with pcRTA.

With the real time measurements being displayed on the screen, you can
adjust the electrical components and/or the acoustic environment and watch
the changes appear as you make them.

1: Measuring System Response
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White Noise Spectrum
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Pink Noise Spectrum
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Pink Noise
The most common noise source used is Pink Noise. You may be asking:
What is Pink Noise and Why Should I Use It? The simple answer is that
pink noise will produce a flat line on the pcRTA when averaged over time.
Pink noise is equal energy per octave (log frequency) and white noise is
equal energy per linear frequency. The pcRTA displays in octaves (log
frequency), so a pink noise signal produces a flat line, while a white noise
signal produces a line that rises with frequency at a rate of 3dB per octave.

The ocean produces a
natural pink noise. White
noise is the sound you
hear from the electronic
components in a sound
system when no music is
playing.

These graphs show what
pink noise and white
noise look like on the
pcRTA screen.
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You can use the internal generator in pcRTA, or an external source such as a
CD or tape with pink noise on it. Using the internal pink noise source is highly
recommended, because it is very precise (repeatable). Using any other pink
noise source can give misleading results. Test disks may not have true pink
noise on them, they may have just a close approximation.

If you want to verify the precision of any pink noise source, you can measure
it with pcRTA. To measure an external source, plug it into the Line Input. Set
the Input Source on the Control Panel to Line Input. Set the Detector on the
Control Panel to Leq with an averaging time of at least 5.00 Seconds. Longer

average times will yield more accurate results. When
you run a test with these settings, you should see a flat
line across the screen. The flatter the line, the more
precise the pink noise source.

If you must use an external pink noise source, you can
use the relative measurement mode to compensate for
any problems in the response of the source. To do this,
store the measurement of the pink noise source in one
of the curve library entries. Go to the Control Panel and
set the Measurement Data to Relative. Click on the list
box in the Measurement Data section of the Control
Panel and select the library entry that contains your
measurement of the external pink noise source. This
curve becomes the reference for any measurements
taken while in the relative mode. Click OK.

The measurements taken under these conditions will respond as if the
external pink noise source is flat, even if it isn't. Keep in mind that these
measurements do not relate to absolute SPL values, but are related to the
original signal level of the external pink noise source.

An alternative to using the relative measurement mode is to divide the
measured curve that you want to correct by the stored measurement of the
external pink noise source. This will remove any variations in frequency
response that were present in the external pink noise source.
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Setting Up For Measurements
The first step is to connect a noise source to the system. If you are going
to use the internal pink noise source, you will need to find a place to 'patch'
into the system. Usually, you can just disconnect the head unit and plug
the pcRTA into the cable that leads to the rear of the car. Make sure that
the total cable length from the pcRTA to the first piece of electronics in
the system is no longer than 100 feet.

The next step is to set up the microphone(s). The MDF files for each
microphone must be loaded into the pcRTA software. If you have not
done this, refer to the pcRTA manual and load the MDF files. The
microphone(s) should be placed in the approximate position of the
driver's head. The mic stand should be a cylinder with the smallest
possible diameter. Any flat surface near the microphone will cause a
reflection at some high frequency.

When running cables into and out of the vehicle, you should use a part
of the window, door or trunk that has a rubber seal on it. This will provide
some measure of padding to prevent damage to the cables.

NOTE: Care should be taken to start with a low level of output from the
internal noise source, because it is very easy to send a full level signal into
the amplifier(s). This could be dangerous to loudspeakers and human ears.
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2: Vehicle Acoustics
The goal of this discussion is to point out the major aspects of vehicle
acoustics. Later sections will show you how to measure them with the pcRTA.

The acoustic space inside a vehicle is one of the most difficult and demanding
environments in which to install a sound system. The small size of the space
and the varying reflective and absorptive surfaces within it create many
problems when optimizing a system for sound quality.

On the other hand, the small size makes it possible to create Sound Pressure
Levels (SPL) at low frequencies that would require much more power and
many more speakers in a larger space.

Standing Waves
When designing a car audio system, you must take into consideration the
effect of standing waves. Sometimes known as 'modes', they are a major
problem in car audio situations.

Whenever there is sound in an enclosed environment, there will be standing
waves within that environment. Standing waves occur at frequencies whose
wavelengths correspond to twice the distance between the walls of the space.
In cars, standing waves typically occur between 50Hz and 200Hz depending
on the size of the vehicle.

It is important to understand that there are several modes (standing waves)
in any car, and when these modes are combined they can cause large peaks
or dips in the frequency response curve. This is because the standing waves
will be at different phase angles. When two waves at the same frequency and
equal phase combine, they increase the SPL at that frequency. When two
waves at the same frequency and opposite phase combine, they decrease the
SPL at that frequency.

Standing waves are very apparent when measuring at a single point in space.
As the point of measurement is changed, the peaks and dips caused by the
standing waves will appear at different frequencies across the spectrum. For
this reason it is recommended that measurements be taken at several
different points in space and then averaged. This technique is called spatial
averaging, and is explained in greater detail in a later section.
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Low Frequency Pressurization (Cabin Gain)
Another major factor affecting low frequency response in vehicles is the
pressurization caused by the speakers being in an enclosed environment.
When a  volume of air is sealed, it will have an effect on the low frequency
response of speakers in that space.

The effect of this sealed environment is a dramatic boost of sound at the
lowest frequencies. This rising response can be used to help flatten the
low frequency rolloff of a cabinet.

The extent of the effect depends on the size of the passenger compart-
ment and how much leakage there is. Leakage is the amount of pressure
which escapes to the outside, and is caused by the sheet metal of the body
flexing and other leaks such as open windows and holes.

The volume (cone area) of the speakers used to pressurize the space will
also have an effect on the amount of low frequency boost. A large cone
area will create more boost than a small one. This is true whether you are
using a single very large speaker or a number of smaller speakers.

This graph shows the response change caused by a 110ft³ space with
20in² of leakage using a single 15" speaker. This curve does not include
any changes caused by standing waves.

Low Frequency Pressurization
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External Noise
Noise from outside the vehicle's compartment has a negative effect on the
listening experience. Road noise and engine noise can become a very
significant part of the sound inside the vehicle. This noise can be reduced
greatly by the use of dampening materials in the doors and on the surfaces
of the passenger compartment.

Electrical Noise
Noise from the ignition system and electromechanical devices such as heater
fans can be extremely annoying even at very low levels. These noises are
usually present only when some part of the system is improperly grounded.

Calculation vs. Measurement
While it is possible to estimate the effects of standing waves and closed-field
low frequency pressurization mathematically, the results would be only an
approximation. Accurate calculation of these effects would require so much
raw data about the vehicle that  it would not be practical. Also, there is no way
to predict the amount of external noise and electrical noise you will observe.

The fastest, easiest and most accurate way to account for all factors in the
vehicle's environment is to measure them. Standing waves and closed-field
pressurization can be measured together as a single transfer function.
Troubleshooting noise problems is much easier when you can check your
progress against a reference measurement.
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3: Measuring Transfer Functions
What is Transfer Function?
Transfer function is the ratio of two measurements. It can be determined by
dividing one measurement by another. Commonly the transfer function of a
device is simply the output divided by the input. Crossovers, equalizers, amps,
speakers, wires, and acoustic environments all have transfer functions. Some
of these devices have transfer functions which can be ignored, such as large
gauge speaker wire and high quality amplifiers.

Measuring the transfer function of a passive crossover can be very useful
when designing a system. It will show you if your crossover is working
correctly, and what the crossover is doing to the signals fed to it.

Knowing the transfer function of the acoustic environment of the vehicle is
extremely helpful when designing woofer enclosures. With a measured curve
of a vehicle's transfer function, you can accurately predict the response of a
cabinet in a vehicle before you actually install it. This can save enormous
amounts of time and money.

If you know that the frequency response being fed to a device is flat, you can
just measure the output of the device to determine it's transfer function. The
difference that the device causes is then directly measured. If the response
being fed to a device is not flat, then that response must be saved for later use
in a division process to determine the transfer function through the device.

Pink Noise Source Equalizer Crossover

Transfer Function

of Equalizer

Transfer Function

of Crossover

Transfer Function

of Equalizer and 


Crossover

Measurement at Input

of Equalizer Divided by 


Measurement at Output

of Crossover
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Transfer Function of Acoustic Environments
To measure the transfer function of the acoustic environment inside the
vehicle, you will need a test cabinet and an amplifier. It is not necessary
for the test cabinet to have an extremely flat response, because it will be
used as a relative reference only. The test cabinet should, however, have
about the same volume of speakers as the final installation. It should also
have very close to the same air volume and port tuning as the final cabinet.
This will assure accuracy of the low frequency pressurization.

This technique will not provide much valuable information at the higher
frequencies, because you cannot place the midrange drivers and tweet-
ers where they will be in the final installation. For this reason, you may
elect to use just a woofer cabinet and concentrate on the frequencies
below 200Hz.

You must first measure the reference cabinet in a free field environment.
The recommended method is to take a ground-plane measurement. This
means to place the reference cabinet on the ground and the microphone
on the ground 1 meter away. Using a low output level (about 1 Watt),
measure the speaker with pink noise. Save the response curve as a
reference.

Microphone

Reference Cabinet

Ground Plane Measurement
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Next, place the reference cabinet inside the vehicle (closed field) and measure
it again with the same pink noise signal at the same level. Save the response
curve for comparison.

These graphs show the response curves of a bandpass cabinet in free field and
inside the car. Note the extreme SPL boost at 50Hz on the closed field
response. This is typical of bandpass cabinets in cars.

Bandpass in Free Field
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Bandpass in Closed Field
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Now, go to the Processing menu of the pcRTA software and select Divide.
Divide the comparison (closed field) curve by the reference (free field) curve.
The result is the transfer function of the vehicle. This is the change in response
that any speaker of the same volume as the reference will exhibit when placed
in this particular vehicle. It includes the closed field pressurization and the
standing waves that are present in the vehicle's acoustic environment.

This transfer function can be saved for
future reference when designing sys-
tems for the same type of vehicle. To
see the response of a woofer cabinet
with the same volume of speakers and
the same port tuning in this particular
vehicle, measure the cabinet in a free
field environment and then multiply
the measured curve by the previously
saved transfer function.

The graph below shows the transfer
function that resulted from the two
bandpass cabinet measurements
shown on the previous page.

Transfer Function
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Transfer Function of  Passive Crossovers
To measure the transfer function of a passive crossover, you need a
power amplifier and the speaker(s) that the crossover will be attached to.

Passive crossovers should be measured with the speaker load. The
speaker presents a reactive load, meaning that the impedance of the
speaker changes depending on frequency. When measured with a
resistive load, you will see the theorectically 'perfect' response from the

textbook as demonstrated in the
top graph. Because speakers are
not purely resistive loads, this
type of measurement is not very
useful. The bottom graph shows
the same crossover with an 8
Ohm speaker load.

NOTE: When measuring the out-
put of a power amplifier, be very
careful not to exceed the maxi-
mum input voltage of the pcRTA.
Voltages in excess of 5.8VRMS
will DESTROY the electronics.

Connect the Line Out of pcRTA
to the input of the amplifier. If
you are using an amplifier that is
known to have flat frequency
response, connect the Line In of
pcRTA to the speaker terminals.
The resulting measured curve
will be the transfer function of
the crossover. This is the voltage
input to the speaker after the
crossover.
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If you suspect that your power amplifier does not have a flat frequency
response, you should measure the transfer function of the amplifier. Set the
amplifier's gain control to a low setting. Connect the pcRTA's Line Out to the
amplifier's input and the Line In to the amplifier's output. The resulting curve
will be the transfer function of the amplifier. If you find that the amplifier does
not have a flat frequency response, divide the measured curve of the amp by
the measured curve of the crossover to correct for the error introduced by the
amplifier.

NOTE: It is important to observe the maximum input voltage of the pcRTA.
NEVER allow the voltage at the Line Input to exceed 5.8VRMS or severe damage
will result.
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4: Measuring Road Noise
Road noise is the background noise level caused by the tires against the
road, the air flowing over the car, and mechanical noises from the engine
and drive train. These noises must be measured while the vehicle is being
driven.

To measure road noise inside the vehicle you will need a portable
computer and the PAC3 (Portable Analyzer Chassis - 3 slot) from LinearX.
The PAC3 is a battery powered slot card holder which interfaces with the
serial port on PC compatible computers. It will run for several hours
without AC power.

Characterizing Road Noise
You can localize the source of various road noises by moving the
microphone to different locations in the vehicle while it is being driven.
If you save the measurements with a note about where each was taken,
you can compare them to measurements after adding dampening
materials to the passenger compartment.

With an RTA, you can get an idea not only of where the noise is, but what
is causing it. If you see a peak in the high frequencies, it might be wind
coming through a leak in the weather-stripping. A constant low frequency
peak is probably caused by the drive train and the tires moving on the
pavement. A mid-low peak that changes in frequency when you rev up
the engine is probably mechanical engine noise.
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5: Measuring Electrical Noise
Electrical noise is the background noise level caused by the electrical
energy generated by the car's engine and other electrical devices. This
type of noise is only present while the engine is running or while one of
the other devices is running.

To measure electrical noise, connect the output of the power amplifier to
the Line Input of the pcRTA. Measure the system noise with the engine
off by turning the volume all the way up with no signal. Use a long
averaging time (at least 5 Seconds). This is the background noise or noise
floor of the electronic components in the system.

This type of measurement can be very dangerous, because power
amplifiers are capable of COMPLETE DESTRUCTION of the circuitry of
the pcRTA, and might damage your computer as well. If you are uncertain
of the need for this test, DO NOT ATTEMPT IT! Your warranty will not
cover repairs of this type of damage.

CAUTION: NEVER allow the voltage at the Line Input of the pcRTA to
exceed 5.8VRMS or severe damage will result.

Start the engine and take another measurement. You can use the relative
mode, or divide the measured curve by the stored curve of the noise floor.
Any difference observed is the noise caused by the engine's electrical
systems.

It is usually very easy to determine which device is causing the noise,
because the noise will have a frequency which corresponds to the
frequency of the device. For instance, if the noise has a higher frequency
when you rev up the engine, it is probably ignition noise. If the noise
changes when you change the heater fan from low to high, it is noise from
the fan.

Electrical noises in cars are usually due to improper grounding schemes
in the stereo installation. The solutions for these problems is beyond the
scope of this manual.
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6: Adjusting With an Equalizer
Equalizers
The ideal equalizers for tuning with pcRTA will be stereo (or two separate
mono) 1/3 octave units, meaning that they have two sets of 31 adjustments.
Most equalizers of this type have their bands centered at the same frequen-
cies as pcRTA, which makes adjustment very easy. If your equalizer has less
than 31 bands you can still measure and adjust it with pcRTA.

Another feature to look for in an equalizer is the 'graphic' style of adjustment.
This simply means that the unit has linear sliders instead of rotary knobs. When
you make an adjustment on such a unit, it leaves a 'graphic' representation of
the frequency response change being added by the equalizer. This is much
more intuitive than several rows of round knobs.

Programmable Equalizers
In recent years, equalizers have been developed that can be adjusted by a
computer. These equalizers typically do not have any controls on the front
panel, with the occasional exception of a few buttons which allow for
adjustment if no computer is present. These equalizers can be automatically
programmed by pcRTA while measurements are being taken, so that pcRTA
actually adjusts the eq to achieve the operator's ideal target response. This
process is called optimization. For more information, see the help file in the
pcRTA software.
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Adjusting for Flatness
Set the volume of the system to a moderate level, around 90dB SPL on
the full range band of the pcRTA. Turn off the right channel of the system
by using the balance control or disconnecting the signal. Adjust the
equalizer on the left channel for a smooth, flat response from 20Hz on up
to 20kHz. Frequencies below 200Hz require special attention because of
the unique demands of the acoustic environment of vehicles, as discussed
in an earlier section. Save the curve now for use when tuning the right
channel of the system.

Turn off the left channel of the system and turn on the right channel . Using
the saved curve from the left channel as a reference, adjust the right
channel until the left and right channels are as close to identical as
possible. It will require different settings on the equalizer's left and right
channels to make the two channels match on the pcRTA display.

Now turn on the left and right channels together. Adjust the equalizer for
a flat response again, making the same relative changes on both channels.
For example, if you move the left channel's 1kHz band down 3dB from
0dB to -3dB and the right channel's 1kHz band is at -2dB, move the right
channel's 1kHz band down 3dB also to -5dB. This will maintain the relative
flatness between the left and right channels.

It is best to keep the bands of the equalizer as close to 0dB as possible,
and not to have any drastic changes between one band and the next. If
your system requires drastic equalization, chances are that something in
the system needs to be reworked. Check for major problems in the
installation.

The one exception to this is in the frequencies from 50Hz to 200Hz.
Because of standing waves, you may see dramatic peaks and/or dips in
the response at these frequencies. For the most accuracy possible, you
should use spatial averaging to tune the system. The next section discusses
this technique.
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7: Spatial Averaging

Mic Position 4

Mic Position 3

Mic Position 1

Mic Position 2

Spatial Averaging - both front seats

What is Spatial Averaging?
When measuring acoustic environments, a single microphone will read
the sound pressure at only one tiny point in space. Errors in measurement
occur because of standing waves and combing, which create peaks and
dips in the response curve that vary with different mic positions. Spatial
Averaging is a method of reducing the error due to this effect.

This technique is quite simple. Take measurements at several points in
space with the same stimulus and average the measurements.

The pcRTA has the built-in capability to do spatial averaging in real time.
You must have at least two microphones to take advantage of this feature,
however. If you have only one microphone, you can manually perform
spatial averaging, but it is more time consuming.

Make your measurements in zones
around the listening position(s). Small
distances between the microphones
will provide averaging at high fre-
quencies. For low frequencies, the
mics must be several feet apart to
provide averaging. Also, it is best to
use long averaging times when you
are striving for high accuracy in your
measurements.

M
ic 

1

M
ic 

2 M
ic 4

M
ic 3

Spatial Averaging - driver's seat
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The measurements shown here were taken at four positions across the car in
the front seat as shown in the lower diagram on the previous page. The mics
were placed at head level.

The following two graphs show four curves, one from each of the four
separate mic positions. These graphs illustrate what you would see with four
mics set to measure in the Multiplex mode. Each mic is displayed separately
and the data is saved separately in the first four curve entries. This can also be
done with a single microphone, by moving it to each position to take four
separate measurements, but it is a very tedious procedure.

The first graph was taken with
the left channel of the sound
system turned on and the right
channel turned off.

The second graph was taken
with the left channel off and
the right channel on.
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These graphs illustrate what you would see with four mics set to measure
in the Average mode. The data from the four mics is averaged in real time
and displayed as a single curve.

The upper graph is the average with only the left channel of the sound
system turned on and the lower graph is the average with only the right
channel turned on.
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If you have only one microphone, you will need to average the measurements
manually after running the individual tests.

Before you take the first measurement, go to the Curve Library and give
names to the all of the curves you will use. This will simplify the process of
saving multiple data curves. Set the first curve number to be the data curve
by pressing the oval next to the curve name in the Curve Library. Run the test,
and then move the microphone to it's next position. Go to the Curve Library
to set the next curve as the data curve. Continue this procedure until you have
as many measurements as you want for your average.

Data Indicator
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Once you have several curves measured, go to the Processing menu and
select Averaging. Click on all the curves you want to average, and select
an empty entry for the result curve.

The results will be the same as the graphs on previous pages, however
with only one mic the average cannot be observed in real time without
post processing of the data.
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8: Measuring Impedance
There are two different types of impedance measurement available in the
pcRTA. They are 2-wire and 4-wire.

The 2-wire method uses only the Line Output of the pcRTA. It requires only
one cable with two leads connected to the device to be tested. The accuracy
of measurements taken with the 2-wire depend on the user subtracting the
short circuit impedance of the cable from the measured curve.

The 4-wire method uses the Line Output and the Line Input of the pcRTA. It
requires two cables with two leads each connected to the device to be tested.
The measurements that are taken with this method do not require any
processing. All examples in this section were measured with the 4-wire
method.

The impedance measurement capability can be used on individual speakers
as shown in these graphs. The first is an 8 Ohm woofer with an Fo (resonant
frequency) of about 30Hz. The general shape of the curve is the characteristic
one seen on nearly all loudspeakers, with a narrow peak or 'hump' at the low
end and an upward slope at the high end.

Impedance Response of 8 Ohm Woofer
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Impedance Response of 4 Ohm Tweeter

This graph shows the impedance response of a 4 Ohm metal dome
tweeter. It has an Fo of about 2.3kHz. The resonant frequency 'hump' is
difficult to pick out because it's magnitude is only about 1/2 Ohm higher
than the nominal impedance. This is a very common type of curve seen
on tweeters.
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This graph shows the impedance response of a three way system with a
passive crossover. It was measured at the input to the passive crossover
circuits. This type of measurement is useful for determining whether the
amplifier will see an impedance at any frequency that could cause it to go into
protection. It will also alert you to possible wrong connections and short or
open circuits.

Impedance Response of Three-way System
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2nd Order Lowpass into 8 Ohm Woofer

The graphs below show the impedance response of a 2nd order passive
lowpass circuit, first into an 8 Ohm resistor, and then into an 8 Ohm
woofer.

It was measured at the input to the passive crossover circuits. Again, this
type of measurement can alert you to possible wrong connections and
short or open circuits.

2nd Order Lowpass into 8 Ohm Resistor
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9: Scoring Routines
This section is a judge's guide to using the car audio competition scoring
routines. The IASCA routine will be used as an example, but you should be
able to use this guide with all of the scoring routines. There are routines for
CMAA, USAC, and dB Drag racing.

The scoring routines in the pcRTA are based on the current rules from each
of the sanctioning bodies. If the rules change, the software is changed to
reflect the new rules. Updates of the software are available from the LinearX
BBS and on the World Wide Web at the LinearX home page.

LinearX BBS:  1(503)598-9326

LinearX Web Address:  http://www.linearx.com/~linearx

Figures are used extensively in this section, so that you will know what the
software should look like at each step.
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There are many graphic elements of the pcRTA software that can be
adjusted or manipulated by the user. To duplicate the look of a particular
graphics setup can be challenging. For this reason, we have incorporated
the Graph Display Set (GDS) files feature. GDS files keep track of all
colors, fonts, window locations and window sizes. Using these files, you
can recall the exact look that you saved previously, and there are some
generic files included with the software.

The first step in this section
will be to load the GDS file
called scoring.gds. To load
the GDS file, go to the File
menu and select Load Graph
Display Set.

Load Graph Display Set

The Load Graph Display Set File dialog box opens. Select the GDS file
scoring.gds by double clicking the file name.

Double Click
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Your screen will look some-
thing like this:

Next, hide the Curve Box and
the Tool Bar. Go to the View
menu and select Hide Curve
Box. Go to the View menu
again and select Hide Tool Bar.

Hide Curve Box

Hide Tool Bar

Now, select System Options from the Edit menu.
Set the Artwork View to Data Area and the
Window Update to Multi Mode. Click OK.

Multi Mode

Data Area

System Options
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Super VGA 1024x768 Display

VGA 640x480 Display

Super VGA 800x600 Display

It is important to understand that the window loca-
tions and sizes in this file were set on a VGA screen
resolution of 640x480. If your computer is running in
a SuperVGA mode (800x600, 1024x768, or higher),
the graphs will use a smaller portion of the screen.
The figures on this page illustrate the same GDS file
at three different screen resolutions.

If your screen resolution is
higher than VGA 640x480,
you will probably want to
drag the corners of the win-
dows out to fill the screen.
Once you have the screen
set up the way you like it,
save your settings in a GDS
file so that you can recall
them any time.
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Control Panel icon

Printers icon

Desktop icon

Use Print Manager Button

Screen Saver Name
drop down list

When running the scoring routines in pcRTA, it is critical that there are no
screen saver programs running, and that the print spooling options are
disabled. These options tie up the CPU during tests and can cause invalid
readings from pcRTA.

In Windows 3.x, go to the Main window and open Control Panel. Double click
on the Desktop icon and click on the Screen Saver Name drop down list.
Select (None) and click OK. Now double click on the Printers icon. Turn off
the Use Print Manager option and click Close.
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Screen Saver Drop Down List

Display icon

Print Directly to Printer
Button

Details Tab

Printers
Folder

In Windows 95, use the Settings button on the Start bar to open Control
Panel. Double click on the  Display icon. Click on the Screen Saver tab,
and then select (None) on the Screen Saver drop down list.  Click OK.

Now double click on the Printers
folder. Double click on the printer
that you will be using. Click on
the Details tab. Select Print di-
rectly to the printer and then
click OK. Click OK again.
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IASCA Scoring

Start Testing button

IASCA Scoring Dialog Box

Go to the Utilities menu and select Scoring. A drop down menu appears.
Select IASCA.

The IASCA Scoring dialog box opens. Click on Start Testing.
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Restart Sequence
Button

Yes button

Note that the Start Testing button now says Stop Testing.

When starting a new competition, you will want to use the Restart
Sequence button. This button should only be used once, before anyone
has been scored. If the sequence is restarted during a competition, some
of the scores of previous competitors will be erased and replaced with
new ones.

Click the Restart Sequence button.

A message box will pop up asking if you really want to restart the
sequence. Click the Yes button.
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Event Title field

Mic-1 Input button

Print Each Graph
button

Now, enter the name of the competition. To do this, click the mouse inside
the area that says Event Title. Erase the old name and type in the name of the
competition.

The pcRTA has the ability to use any of the four mic inputs or the Line Input
as sources for the scoring. This allows for multiple lanes to be measured with
one pcRTA. For single lane testing, the Mic-1 input should always be selected.
Verify that this is true.

You are now ready to start scoring. The preceding steps should only need to
be done once, at the beginning of a competition.

Click the Print Each Graph button if you want printouts of each competitor's
results.
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Contestant field

Level Setting Test button

Enter the competitor's name in the area marked Contestant.

Press the Level Setting Test button.
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...Push When Done
button

Text Chart
(Set for 90dB)

The text inside the button changes to ...Push When Done.

At this point, the pcRTA is measuring the pink noise in the car. Have the
competitor set their system for a 90dB (+ or - 1dB) indication on the Text Chart
in the upper left corner of the screen and then press ...Push When Done.



40 pcRTA - Car Audio Addendum

Car Audio Applications

RTA Response Test
button

SPL Max Test button

Have the competitor restart the pink noise track on the CD and press the
RTA Response Test button.

The pcRTA now takes a 10 second average of the pink noise in the car.
At first, the Bar Graph will update quickly, and then it will freeze for 2
seconds while the pcRTA is taking measurements. The graph will be
updated 4 more times, 2 seconds apart. After ten seconds, the test is
finished. The RTA score appears in the text box below the Contestant
field. If desired, the test can be run again by pressing the RTA Response
Test button again.

Now, if you are doing Sound Q+ on this competitor, press the SPL Max
Test button.
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Produce IASCA Score
button

The competitor now has 30 seconds to achieve the highest reading that they
can. The pcRTA will capture the loudest signal and continue to hold that level
until a louder level is measured, or 30 seconds elapses. The SPL score appears
in the text box below the Contestant field. If desired, the test can be run again
by pressing the SPL Max Test button again.

NOTE: The competitor should not be allowed to open the doors of the vehicle
while the test is running. This can sometimes result in higher SPL levels than
would be possible with the doors closed.

After the 30 second SPL Max test, press the button labeled Produce IASCA
Score.

This button will cause the pcRTA to score the RTA curve (and SQ+ value) and
place the score in memory. This is the last step in the procedure.

To score the next competitor, follow the procedure again starting from page
38.

If you need to print someone's score after the car has left the lane, follow the
procedure on the next page.
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Curve Library

Show Info button

Data button

To retrieve a previous score, go to the Edit menu and open the Curve
Library.

The Curve Library dialog box opens. Click on the Data button on the
curve that you need.

Click on the Show Info button.
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Transfer to Notes
button

The Curve Information dialog box opens. This is the IASCA score that is saved
in memory for this competitor.

Click on the Transfer to Notes button. Click OK. Click OK again. The
competitor's score is now displayed in the Notes and Comments field of
the graphs. To print, go to the File menu and select Print.

If you need to continue scoring, simply start the scoring routine again. The
software will automatically start at the last curve entry and will not over-
write any of the previous scores (unless the Restart Sequence button is
used).



44 pcRTA - Car Audio Addendum

Car Audio Applications


